
Chapter 7

Controlling the Drawing
Display and Creating Text

After completing this chapter, you will be able to:
•  Use the REDRAW and REGEN commands.
•  Use the ZOOM command and its options.
•  Understand the PAN and VIEW commands.
•  Understand the use of the Aerial View window.
•  Draw text using the TEXT command.
•  Create paragraph text using the MTEXT command.
•  Edit text using the DDEDIT command.
•  Use the PROPERTIES palette to change the properties of the text.
•  Substitute fonts and specify alternate default fonts.
•  Create text styles using the STYLE command.
•  Determine text height.
•  Check spellings and find and replace text.

Learning Objectives
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Menu: View > Redraw
Command: REDRAW

BASIC DISPLAY OPTIONS
Drawing in AutoCAD LT is much simpler than manual drafting in many ways. Sometimes while
drawing, it is very difficult to see and alter minute details. In AutoCAD LT, you can overcome
this problem by viewing only a specific portion of the drawing. For example, if you want to
display a part of the drawing on a larger area, you can use the ZOOM command, which lets you
enlarge or reduce the size of the drawing displayed on the screen. Similarly, you can use the
REGEN command to regenerate the drawing and REDRAW to refresh the screen. In this
chapter, you will learn some of the drawing display commands, such as REDRAW, REGEN,
PAN, ZOOM, and VIEW. These commands can also be used in the transparent mode.
Transparent commands are commands that can be used while another command is in progress.
Once you have completed the process involved with a transparent command, AutoCAD LT
automatically returns you to the command with which you were working before you invoked the
transparent command.

REDRAWING THE SCREEN

The REDRAW command redraws the screen and is used to remove the small cross marks (blips)
that appear when a point is specified on the screen when BLIPMODE is set to on. The blip
mark is not treated as an element of the drawing. The REDRAW command also redraws the
objects that do not display on the screen as a result of editing some other object. In AutoCAD
LT, several commands redraw the screen automatically (for example, when a grid is turned off),
but it is sometimes useful to redraw the screen explicitly.  In AutoCAD LT, the REDRAW
command can also be used in the transparent mode. This can be done by typing an apostrophe
in front of the command. The apostrophe appended to a command indicates that the command
is to be used as a transparent command (Command: ‘REDRAW). Use of the REDRAW command
does not involve a prompt sequence; instead, the redrawing process takes place without any
prompting for information.

The REDRAW command affects only the current viewport. If you have more than one viewport
you can use the REDRAWALL command to redraw all the viewports. Redraw in the View menu
is the REDRAWALL command.

Tip
While working on complex drawings, it may be better to set the BLIPMODE variable as Off
(default) instead of using the REDRAW command to clear blips.

REGENERATING THE DRAWING

The REGEN command makes AutoCAD LT regenerate the entire drawing to update it. The
need for regeneration usually occurs when you change certain aspects of the drawing. All objects

Menu: View  > Regen
Command: REGEN
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in the drawing are recalculated and redrawn in the current viewport. One of the advantages of
this command is that the drawing is refined by smoothing out circles and arcs. To use this
command, enter REGEN at the Command prompt. AutoCAD LT displays the message
Regenerating model while it regenerates the drawing. The REGEN command affects only the
current viewport. If you have more than one viewport, you can use the REGENALL command to
regenerate all of them. The REGEN command can be aborted by pressing ESC. This saves time
if you are going to use another command that causes automatic regeneration.

Tip
Under certain conditions, the ZOOM and PAN commands automatically regenerate the
drawing. Some other commands also perform regenerations under certain conditions.

ZOOMING DRAWINGS

Creating drawings on the screen would not be of much use if you can not magnify the drawing
view to work on the minute details. Getting close to or away from the drawing is the function of
the ZOOM command. In other words, this command enlarges or reduces the view of the drawing
on the screen, but it does not affect the actual size of the objects. In this  way, the ZOOM
command functions like the zoom lens on a camera. When you magnify the apparent size of a
section of the drawing, you see that area in greater detail. On the other hand, if you reduce the
apparent size of the drawing, you see a larger area. With this release of AutoCAD LT, zooming of
the entities is animated. You can see the transition of entities from the initial state to the zoomed
state.

The ability to zoom in, or magnify, has been helpful in creating the minuscule circuits used in
the electronics and computer industries. This is one of the most frequently used commands.
Also, this command can be used transparently, which means that it can be used while working in
other commands. The ZOOM command can be invoked transparently from the Zoom toolbar,
as shown in Figure 7-1 or by right-clicking in the drawing area and choosing Zoom from the
menu. This option is also available in the shortcut menu that is displayed even when you are
inside some other command, as shown in Figure 7-2.

Toolbar: Zoom toolbar or Standard > Zoom flyout
Menu: View > Zoom
Command: ZOOM

Figure 7-2  Invoking the ZOOM command from the
LINE command shortcut menu

Figure 7-1  Selecting the Zoom options from the
Zoom toolbar
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 Figure 7-3  Drawing showing limits Figure 7-4  The Zoom All option

This command has several options and can be used in a number of ways. The following is the
prompt sequence that is displayed when you invoke this command.

Command: ZOOM������
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>:

Realtime Zooming
You can use the Realtime Zoom to zoom in and zoom out interactively. To zoom in,
invoke the command, then hold the pick button down and move the cursor up. If you
want to zoom in further, release the pick button and bring the cursor down. Specify a

point and move the cursor up again. Similarly, to zoom out, hold the pick button down and
move the cursor down. If you move the cursor vertically up from the midpoint of the screen to
the top of the window, the drawing is magnified by 100% (zoom in 2x magnification). Similarly,
if you move the cursor vertically down from the midpoint of the screen to the bottom of the
window, the drawing display is reduced 100% (zoom out 0.5x magnification). Realtime zoom is
the default setting for the ZOOM command. Pressing ENTER after entering the ZOOM command
automatically invokes the realtime zoom.

When you use the realtime zoom, the cursor becomes a magnifying glass and displays a plus sign
(+) and a minus sign (–). When you reach the zoom out limit, AutoCAD LT does not display the
minus sign (–) while dragging the cursor. Similarly, when you reach the zoom in limit, AutoCAD
LT does  not display the plus sign (+) while dragging the cursor. To exit the realtime zoom,
press ENTER or ESC, or select Exit from the shortcut menu.

All Option
This option of the ZOOM command adjusts the display area on the basis of the
drawing limits (Figure 7-3) or extents of the object, whichever is greater. Even if the
objects are not within the limits, they are still included in the display. Hence, with the

help of the All option, you can view the entire drawing in the current viewport (Figure 7-4).
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Center Option
This option lets you define a new display window by specifying its center point
(Figures 7-5 and 7-6) and the magnification or height. Here, you are required to enter
the center and the height of the subsequent screen display. If you press ENTER instead

of entering a new center point, the center of the view will remain unchanged. Instead of entering
a height, you can enter the magnification factor by typing a number. If you press ENTER at the
height prompt, or if the height you enter is the same as the current height, magnification does
not take place. For example, if the current height is 2.7645 and you press ENTER at the
magnification or height <current> prompt, magnification will not take place. The smaller the
value, the greater the enlargement of the image. You can also enter a number followed by X. This
indicates the change in magnification, not as an absolute value, but as a value relative to the
current screen.

The prompt sequence is given next.

Command : ZOOM �
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: C �
Specify center point : Specify a center point.
Enter magnification or height <current>: 5X �

In Figure 7-6, the current magnification height is 5X, which magnifies the display five times. If
you enter a value of 2, the size (height and width) of the zoom area changes to 2 X 2 around the
specified center. In Figure 7-7, if you enter .12 as the height after specifying the center point as
the circle’s center, the circle will zoom to fit in the display area since its diameter is 0.12. The
prompt sequence is given next.

Command: ZOOM �
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object]<real time>: C �
Center point: Select the center of the circle.
Magnification or Height <5.0>: 0.12 �

Figure 7-6  Drawing after using the ZOOM
Center option

Figure 7-5  Drawing before using the ZOOM
Center option
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Figure 7-7  Drawing after using the ZOOM
Center option

Figure 7-8  The ZOOM Extents option

Extents Option
As the name indicates, this option lets you zoom to the extents of the biggest object in
the drawing. The extents of the drawing comprise the area that has the drawings in it.
The rest of the empty area is neglected. With this option, all objects in the drawing are

magnified to the largest possible display, see Figure 7-8.

Dynamic Option
This option displays the portion of the drawing that you have already specified. The
prompt sequence for using this option of the ZOOM command is given next.

 Command: ZOOM �
 Specify corner of window, enter a  scale factor (nX or nXP), or
 [All/Center/Dynamic/Extents/Previous/Scale/Window/Object]<real time>: D �

You can then specify the area you want to be displayed by manipulating a view box representing
your viewport. This option lets you enlarge or shrink the view box and move it around. When
you have the view box in the proper position and size, the current viewport is cleared by
AutoCAD LT and a special view selection screen is displayed. This special screen comprises
information regarding the current view as well as the available views. In a color display, the
different viewing windows are very easy to distinguish because of their different colors, but in
a monochrome monitor, they can be distinguished by their shape.

Blue dashed box representing drawing extents
Drawing extents are represented by a dashed blue box (Figure 7-9), which constitutes the larger
of the drawing limits or the actual area occupied by the drawing.

Green dashed box representing the current view
A green dashed box is formed to represent the area that the current viewport comprises when the
Dynamic option of the ZOOM command is invoked (Figure 7-10).
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Panning view box (X in the center)
A view box initially of the same size as the current view box is displayed with an X in the center
(Figure 7-11). You can move this box with the help of your pointing device. This box, known as
the panning view box, helps you to find the center point of the zoomed display you want. When
you have found the center, press the pick button to make the zooming view box appear.

Zooming view box (arrow on the right side)
After you press the pick button in the center of the panning view box, the X in the center of the
view box is replaced by an arrow pointing to the right edge of the box. This zooming view box
(Figure 7-12) indicates the ZOOM mode. You can now increase or decrease the area of this box
according to the area you want to zoom into. To shrink the box, move the pointer to the left; to
increase it, move the pointer to the right. The top, right, and bottom sides of the zooming view
box move as you move the pointer, but the left side remains fixed, with the zoom base point at
the midpoint of the left side. You can slide it up or down along the left side. When you have the
zooming view box in the desired size for your zoom display, press ENTER to complete the
command and zoom into the desired area of the drawing. Before pressing ENTER, if you want
to change the position of the zooming view box, click the pick button of your pointing device to
make the panning view box reappear. After repositioning, press ENTER.

Previous Option
While working on a complex drawing, you may need to zoom in on a portion of the
drawing to edit some minute details. Once the editing is over you may want to return to
the previous view. This can be done using the Previous option of the ZOOM command.

Without this option, it would be very tedious to zoom back to the previous views. AutoCAD LT
saves the view specification of the current viewport whenever it is being altered by any of the
ZOOM options or by the PAN, VIEW Restore, DVIEW, or PLAN commands (which are discussed
later). Up to ten views are saved for each viewport. The prompt sequence for this option is given
next.

 Figure 7-10  Representation of the current view Figure 7-9  Box representing drawing extents
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Command: ZOOM �
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object]<real time>: P �

Successive ZOOM > P commands can restore up to ten previous  views. VIEW here refers to the
area of the drawing defined by its display extents. If you erase some objects and then issue a
ZOOM > Previous command, the previous view is restored, but the erased objects are not.

Window Option
This is the most commonly used option of the ZOOM command. It lets you specify the
area you want to zoom in on, by letting you specify two opposite corners of a rectangular
window. The center of the specified window becomes the center of the new display

screen. The area inside the window is magnified or reduced in size to fill the display as completely
as possible. The points can be specified either by selecting them with the help of the pointing
device or by entering their coordinates. The prompt sequence is given next.

Command: ZOOM �
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object]<real time>: Specify a point.
Specify opposite corner: Specify another point.

Whenever the ZOOM command is invoked, the window method is one of two default options.
This is illustrated by the previous prompt sequence where you can specify the two corner points
of the window without invoking any option of the ZOOM command. The Window option can
also be used by entering W. In this case the prompt sequence is given next.

Command: ZOOM �
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object]<real time>: W �
Specify first corner: Specify a point.
Specify opposite corner: Specify another point.

 Figure 7-11  The panning view box  Figure 7-12  The zooming view box
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Scale Option
The Scale option of the ZOOM command is a very versatile option. It can be used in the
following ways.

Scale: Relative to full view
This option of the ZOOM command lets you magnify or reduce the size of a drawing
according to a scale factor (Figure 7-13). A scale factor equal to 1 displays an area equal
in size to the area defined by the established limits. This may not display the entire

drawing if the previous view was not centered on the limits or if you have drawn outside the
limits. To get a magnification relative to the full view, you can enter any other number. For
example, you can type 4 if you want the displayed image to be enlarged four times. If you want
to decrease the magnification relative to the full view, you need to enter a number that is less
than 1. In Figure 7-14, the image size decreased because the scale factor is less than 1. In other
words, the image size is half of the full view because the scale factor is 0.5.
The prompt sequence is given next.

Command: ZOOM �
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object]<real time>: S �
Enter a scale factor (nX or nXP) : 0.5 �

Scale: Relative to current view
The second way to scale is with respect to the current view (Figure 7-15). In this case, instead of
entering only a number, enter a number followed by an X. The scale is calculated with reference
to the current view. For example, if you enter 0.25X, each object in the drawing will be displayed
at one-fourth (¼) of its current size. The following example increases the display magnification
by a factor of 2 relative to its current value (Figure 7-16).

Command: ZOOM �
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object]<real time>: 2X �

Figure 7-13  Drawing before the ZOOM Scale
option

Figure 7-14  Drawing after the ZOOM Scale
option
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Scale: Relative to paper space units
The third method of scaling is with respect to paper space. You can use paper space in a variety
of ways and for various reasons. For example, you can array and plot various views of your model
in the paper space. To scale each view relative to paper space units, you can use the ZOOM XP
option. Each view can have an individual scale. The drawing view can be at any scale of your
choice in a model space viewport. For example, to display a model space at one-fourth (¼) the
size of the paper space units, the prompt sequence is given next.

Command: ZOOM �
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object]<real time>: 1/4XP �

Note
For a better understanding of this topic, refer to “Model Space Viewports, Paper Space Viewports
and Layouts” in Chapter 11.

Object Option
The Object option of the ZOOM command is used to select one or more than one
objects and display them at the at the center of the screen in the largest possible size.

Zoom In and Out
You can also zoom into the drawing using the In option, which doubles the image size.

Similarly, you can use the Out option to decrease the size of the image by half. To invoke
these options from the command line, enter ZOOM 2X for the In option or ZOOM .5X
for the Out option at the Command prompt. The center of the screen is taken as the

reference point for enlarging or reducing the view of the drawing.

Figure 7-15  Drawing, before the ZOOM Scale
(X) option

Figure 7-16  Drawing, after the ZOOM Scale
(X) option
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Toolbar: Standard Toolbar > Pan Realtime
Menu: View > Pan
Command: PAN

Exercise 1 Mechanical

       Figure 7-17  Drawing for Exercise 1

Draw Figure 7-17 according to the given dimensions. Use the ZOOM command to get a bigger
view of the drawing. Do not dimension the drawing.

PANNING DRAWINGS

You may want to view or draw on a particular area outside the current display. You can do this
using the PAN command. If done manually, this would be like holding one corner of the
drawing and dragging it across the screen. The PAN command allows you to bring into view the
portion of the drawing that is outside the current display area. This is done without changing
the magnification of the drawing. The effect of this command can be illustrated by imagining
that you are looking at a big drawing through a window (display window) that allows you to slide
the drawing right, left, up, and down to bring the part you want to view inside this window. You
can invoke the PAN command from the shortcut menu also.

Panning in Realtime
You can use the Realtime Pan to pan the drawing interactively. To pan a drawing,
invoke the command and then hold the pick button down and move the cursor in
any direction. When you select the realtime pan, AutoCAD LT displays an image of a

hand indicating that you are in the PAN mode. Realtime pan is the default setting for the PAN
command. Choosing the Pan Realtime button in the toolbar and entering PAN at the Command
prompt automatically invokes the realtime pan. To exit the realtime pan, press ENTER or ESC,
or choose Exit from the shortcut menu.
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For the PAN command, there are various options   that
can be used to pan the drawing in a particular direction.
These items can be invoked only from the menu shown
in Figure 7-18.

Point
In this option, you are required to specify the
displacement. To do this, you need to specify in what
direction to move the drawing and by what distance.
You can give the displacement either by entering the
coordinates of the points or by specifying the
coordinates by using a pointing device. The coordinates
can be entered in two ways. One way is to specify a
single coordinate pair. In this case, AutoCAD LT takes
it as a relative displacement of the drawing with respect
to the screen. For example, in the following case, the
PAN command would shift the displayed portion of
the drawing 2 units to the right and 2 units up.

Command: Select the Point option from the View
menu.
Specify base point or displacement: 2,2 �
Specify second point: �

In the second case, you can specify two coordinate pairs. AutoCAD LT computes the displacement
from the first point to the second. Here, the displacement is calculated between point (3,3) and
point (5,5).

Command: Specify the Point item from the View menu.
Specify base point or displacement: 3,3 �  (Or specify a point.)
Specify second point: 5,5 �  (Or specify a point.)

Left
Moves the drawing left so that some of the right portion of the drawing is brought into view.

Right
Moves the drawing right so that some of the left portion of the drawing is brought into view.

Up
Moves the drawing up so that some of the bottom portion of the drawing is brought into view.

Down
Moves the drawing down so that some of the top portion of the drawing is brought into view.

Figure 7-18  Invoking the PAN command
options from the View menu
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Tip
You can use the scroll bars to pan the drawing vertically or horizontally. The scroll bars are
located at the right side and the bottom of the drawing area. You can control the display of the
scroll bars in the Display tab of the Options dialog box.

CREATING VIEWS

While working on a drawing, you may frequently be
working with the ZOOM and PAN commands, and
you may need to work on a particular drawing view
(some portion of the drawing) more often than others. Instead of wasting time by recalling your
zooms and pans and selecting the same area from the screen over and over again, you can store
the view under a name and restore it using the name you have given. Choose the Named Views
button on the View toolbar (Figure 7-19) to invoke the View dialog box. This dialog box is used
to save the current view under a name so that you can restore (display) it later. It does not save
any drawing object data, only the view parameters needed to redisplay that portion of the
drawing.

View Dialog Box
You can save and restore the views from the View dialog box shown in Figure 7-20. This dialog
box is very useful when you are saving and restoring many view names. With this dialog box, you
can name the current view or restore some other view. The Named Views tab lists all the created
named views. The Orthographic and Isometric Views tab lists all the preset views of the drawing,
and allows you to set current any of those views. The following are the various options in the
Named Views tab of the View dialog box.

Current View
The View list box displays a list of the named views in the drawing. The list appears with the
names of all saved views and the space, in which each was defined (Model space and paper space
are discussed in Chapter 11).

New
The New button allows you to create a new view and save it by giving it a name. When you
choose the New button, the New View dialog box is displayed, as shown in Figure 7-21.

View name. You can enter the name for the view in the View name edit box.

View category. You can specify the category of the view from the View category edit box. The
categories include the front view, top view, and so on. If there are some existing categories, you
can select them from this drop-down list also.

Toolbar: View > Named Views
Menu: View > Named Views
Command: VIEW

Figure 7-19  Invoking the Named Views
from the View toolbar
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Boundary Area. This area is used to specify the boundary of the view. If you want to save the
current display as the view, select the Current display radio button. If you want to define a
window that will specify the new view (without first zooming in on that area), select the Define
window radio button. As soon as you select this radio button, the dialog boxes will be temporarily

Figure 7-20  The View dialog box

Figure 7-21  The New View dialog box
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closed and you will be prompted to define two corners of the window. You can modify the
window by choosing the Define View Window button. You can also enter the X and Y coordinates
in the Specify first corner and Specify other corner in the command lines.

Settings Area. This area allows you to save the layers and the UCS with the new view. If you
want to save the settings of the visibility of the current layers with the view, select the Store
Current Layer Settings with View radio button. You can select the Save UCS with view radio
button to save a UCS with the view. The UCS to be saved with the view can be selected from the
UCS name drop-down list.

Set Current
The Set Current button allows you to replace the current viewport by the view you specify.
AutoCAD LT uses the center point and magnification of each saved view and executes a ZOOM
Center with this information when a view is restored.

Update Layers
The Update Layers button is chosen to update the layer information saved with an existing
view.

Edit Boundaries
The Edit Boundaries button is chosen to edit the boundary that was defined using the New
View dialog box while creating the new view.

Details
You can also see the description of the general parameters of a view by selecting  the particular
view and then choosing the Details button. When you choose this button, the View Details
dialog box is displayed.

Tip
You can use the shortcut menu to rename or delete any named view in the dialog box. You can
also update the layer information or edit the boundary of a view using this shortcut menu.

Using the Command prompt
You can also use the -VIEW command to work with views at the Command prompt.

Command: -VIEW �
Enter an option [?/lAyer state/Orthographic/Delete/Restore/Save/Ucs/Window]:

You can use the various options to specify the view category, layer state, save, restore, delete, or
list the views. If you try to restore a Model space view while working in layouts, AutoCAD LT will
prompt you to select a viewport and then automatically switch to the floating model space using
that viewport. In this case, AutoCAD LT will prompt you further as follows.
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Enter view name to restore: Specify the name of the Model space view
Restoring Model space view.
Select Viewport for view: Select the viewport in which the Model space view should be restored.

You can select the viewport you want by selecting its border. This particular viewport must be on
and active. The restored viewport also becomes the current one.

You can use the Window option to define the view. The prompt sequence is given next.

Command: -VIEW �
Enter an option [?/lAyer state/Orthographic/Delete/Restore/Save/Ucs/Window]:
W �
Enter view name to save: Enter the name.
Specify first corner: Specify a point.
Specify opposite corner: Specify another point.

Tip
The options of the VIEW command can be used transparently by entering ‘-VIEW at the
Command prompt.

ARIEL VIEW

As a navigational tool, AutoCAD LT provides you with the option of opening another drawing
display window along with the graphics screen window you are working on. This window, called
the Aerial View window, can be used to view the entire drawing and select those portions you
want to quickly zoom or pan. The AutoCAD LT graphics screen window resets itself to display
the portion of the drawing you have selected for Zoom or Pan in the Aerial View window. You
can keep the Aerial View window open as you work on the graphics screen, or minimize it so
that it stays on the screen as a button which can be restored when required (Figure 7-22). As with
all windows, you can resize or move it. The Aerial View window can also be invoked when you
are in the midst of any command other than the DVIEW command. The Aerial View window
has two menus, View and Options. It also has a toolbar containing zoom in, zoom out, and
zoom global options. The following is a description of the available options in the Aerial View.

Toolbar Buttons
The Aerial View window has three buttons:  Zoom In, Zoom Out, and Global (Figure 7-23).

Zoom In
This option leads to the magnification by a factor of 2 centered on the current view box.

Zoom Out
This option leads to the reduction by half centered on the current view box.

Menu:        View > Aerial View
Command:    DSVIEWER
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Global
The Global option displays the complete drawing in the Aerial View window.

Menus
The menus in the menu title bar are View and
Options. The View menu contains Zoom In,
Zoom Out, and Global options, which are the
same as their respective buttons in the toolbar.
The options in the Options menu are discussed
next.

Auto Viewport
When you are working with viewports, you may
need to change the view in the Aerial View
window to display the current viewport view.
You can achieve this by selecting the Auto
Viewport option from the Options menu. If
you are working in multiple viewports and you
zoom or pan in the Aerial View window, only
the view in the current viewport is affected.

Figure 7-22  AutoCAD LT graphics screen with the Aerial View window

Figure 7-23  The Aerial View window
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Toolbar: Text > Single Line Text
Menu: Draw > Text > Single Line Text
Command: TEXT

Dynamic Update
When you make any changes in the current drawing, the view box is updated simultaneously in
the Aerial View window if you have selected the Dynamic Update option. If Dynamic Update
is unselected, the drawing is not updated simultaneously. The drawing in the Aerial View
window is updated only when you move the cursor in the Aerial View window or invoke any of
the menus or the toolbar buttons.

Realtime Zoom
This option dynamically updates the view in the drawing area when you are zooming in the
Aerial View window in realtime.

CREATING TEXT
In manual drafting, lettering is accomplished by hand using a lettering device, pen, or pencil.
This is a very time-consuming and tedious job. Computer-aided drafting has made this process
extremely simple. Engineering drawings invoke certain standards to be followed in connection
with the placement of a text in a drawing. In this section, you will learn how text can be added
in a drawing by using TEXT and MTEXT commands.

Writing Single Line Text

The TEXT command lets you write text on a drawing and allows you to delete, what has
been typed, by using the BACKSPACE key. You can enter multiple lines in one command.
The TEXT command displays a line in the drawing area where you specified the start

point after entering the height and the rotation angle. This line identifies the start point and
the size of the text height entered. The characters appear on the screen as you enter them. When
you press ENTER after typing a line, the cursor automatically places itself at the start of the next
line and you can enter the next line of the text. You can end the command by pressing the
ENTER key or ESC key at the Enter text prompt.

The screen crosshairs can be moved irrespective of the cursor line for the text. If you specify a
point, this command will complete the current line of the text and move the cursor line to the
point you selected. This cursor line can be moved and placed anywhere on the screen; therefore,
multiple lines of text can be entered at any desired location in the drawing area with a single
TEXT command. By pressing BACKSPACE you can delete one character to the left of the
current position of the cursor box. Even if you have entered several lines of text, you can use
BACKSPACE and continue deleting, until you reach the start point of the first line.

This command can be used with most of the text alignment modes, although it is most useful in
the case of left-justified texts. In the case of aligned texts, this command assigns a height
appropriate for the width of the first line to every line of the text. Irrespective of the Justify
option chosen, the text is first left-aligned at the selected point. The prompt sequence that
follows when you choose this command is given next.
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Specify start point of text or [Justify/Style]: Specify the start point.
Specify height <0.2000>: 0.15 �
Specify rotation angle of text <0>: �
Enter text: Enter first line of the text
Enter text: Enter first line of the text
Enter text: �

Start Point Option
This is the default and the most commonly used option in the TEXT command. By specifying
a start point, the text is left-justified along its baseline starting from the location of the starting
point. Before AutoCAD LT draws the text, it needs the text height, the rotation angle for the
baseline, and the text string to be drawn. It prompts you for all this information. The prompt
sequence is given next.

Specify height <default>:
Specify rotation angle of text <default>
Enter text:

The Specify height prompt determines the distance by which the text extends above the baseline,
measured by the capital letters. This distance is specified in drawing units. You can specify the
text height by specifying two points or entering a value. In the case of a null response, the
default height, that is, the height used for the previous text drawn in the same style, will be used.

The Specify rotation angle of text prompt determines the angle at which the text line will be
drawn. The default value of the rotation angle is 0-degree (3 o’clock, or east), and in this case
the text is drawn horizontally from the specified start point. The rotation angle is measured in
a counterclockwise direction. The last angle specified becomes the current rotation angle, and if
you give a null response, the last angle specified will be used as default. You can also specify the
rotation angle by specifying two points. The text is drawn upside down if a point is specified at
a location to the left of the start point.

As a response to the Enter text prompt, enter the text string. Spaces are allowed between words.
After entering the text, press ENTER.

Justify Option
AutoCAD LT offers various options to align the text. Alignment refers to the layout of the text.
The main text alignment modes are left, center, and right. You can align a text using a combination
of modes; for example, top/middle/baseline/bottom and left/center/right (Figure 7-24). Top refers to
the line along which lie the top points of the capital letters; Baseline refers to the line along
which lie their bases. Letters with descenders (such as p, g, y) dip below the baseline to the
bottom.

When the  Justify option is invoked, the user can place the text in one of the fourteen various
alignment types by selecting the desired alignment option using the command prompt or the
dynamic preview (Figure 7-25). The orientation of the text style determines the command
interaction for Text Justify. (Text styles and fonts are discussed later in this chapter). For now,
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Figure 7-24  Text alignment positions

assume that the text style orientation is horizontal. The prompt sequence that will follow when
you choose the Single Line Text button to use this option is given next.

Specify start point of text or [Justify/style]: J �
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/ BR]: Select
any of these options.

If the text style is vertically oriented (refer to the “Creating Text Styles”
section later in this chapter), only four alignment options are available.
The prompt sequence is as follows.

Specify start point of text or [Justify/Style]: J �
Enter an option [Align/Center/Middle/Right]:

If you know what justification you want, you can enter it directly at the
Specify start point of text or [Justify/Style] prompt instead of first
entering J to display the justification prompt. If you need to specify a
style as well as a justification, you must specify the style first. The
various alignment options are as follows.

Align Option
In this option, the text string is written between two points
(Figure 7-25). You must specify the two points that act as the endpoints
of the baseline. The two points may be specified horizontally or at an
angle. AutoCAD LT adjusts the text width (compresses or expands) so
that it fits between the two points. The text height is also changed,
depending on the distance between points and the number of letters.

Figure 7-25  Dynamic
preview for the Justify
option
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Specify start point of text or [Justify/Style]: J �
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]: A
�
Specify first endpoint of text baseline: Specify a point.
Specify second endpoint of text baseline: Specify a point.
Enter text: Enter the text string.

Fit Option
This option is very similar to the previous one. The only difference is that in this case, you select
the text height, and it does not vary according to the distance between the two points. AutoCAD
LT adjusts the letter width to fit the text between the two given points, but the height remains
constant (Figure 7-27). The Fit option is not accessible for vertically oriented text styles. If you
try the Fit option on the vertical text style, you will notice that the text string does not appear in
the prompt. The prompt sequence is given next.

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]: F
Specify first endpoint of text baseline: Specify a point.
Specify second endpoint of text baseline: Specify a point.
Specify height<current>: Enter the height.
Enter text: Enter the text.

Note
You do not need to select the Justify option ( J) for selecting the text justification. You can enter
the text justification by directly entering justification when AutoCAD LT prompts “Specify start
point of text or [Justify/Style]:”

Center Option
You can use this option to select the midpoint of the baseline for the text. This option can be
invoked by entering Justify and then Center or C. After you select or specify the center point,
you must enter the letter height and the rotation angle (Figure 7-25).

Specify start point of text or [Justify/Style]: C �
Specify center point of text: Specify a point.
Specify height<current>: 0.15 �
Specify rotation angle of text<0>: �
Enter text: CENTER JUSTIFIED TEXT �

Middle Option
Using this option, you can center text not only horizontally, as with the previous option, but
also vertically. In other words, you can specify the middle point of the text string (Figure 7-25).
You can alter the text height and the angle of rotation to your requirement. The prompt
sequence that will follow when you choose the Single Line Text button from the Text toolbar is
given next.

Specify start point of text or [Justify/Style]: M �
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Figure 7-26  Writing the text using the Align, Fit, Center, and
Middle options

Specify middle point of text : Specify a point.
Specify height<current>: 0.15 �
Specify rotation angle of text<0>: �
Enter text: MIDDLE JUSTIFIED TEXT �

Right Option
This option is similar to the default left-justified start point option. The only difference is that
the text string is aligned to the lower right corner (the endpoint you specify); that is, the text is
right-justified (Figure 7-26). The prompt sequence that will follow when you choose this button
is given next.

Specify start point of text or [Justify/Style]: R �
Specify right endpoint of text baseline: Specify a point.
Specify height<current>: 0.15 �
Specify rotation angle of text<0>: �
Enter text: RIGHT JUSTIFIED TEXT �

TL Option
In this option, the text string is justified from the top left (Figure 7-27). The prompt sequence is
given next.

Specify start point of text or [Justify/Style]: TL �
Specify top-left point of text: Specify a point.
Specify height<current>: 0.15 �
Specify rotation angle of text <0>: �
Enter text: TOP/LEFT JUSTIFIED TEXT �
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Note
The rest of the text alignment options are similar to those just discussed, and you can try them on
your own. The prompt sequence is almost the same as those given for the previous examples.

Style Option
With this option, you can specify another existing text style. Different text styles can have
different text fonts, heights, obliquing angles, and other features. This option can be invoked by
entering TEXT and then S at the next prompt. The prompt sequence that will follow when you
choose the Single Line Text button for using this option is given next.

Specify start point of text or [Justify/Style]: S �
Enter style name or [ ?] <current>:

If you want to work in the previous text style, just press ENTER at the last prompt. If you want to
activate another text style, enter the name of the style at the last prompt. You can also choose
from a list of available text styles, which can be displayed by entering ?. After you enter ?, the
next prompt is given next.

Enter text style(s) to list <*>:

Press ENTER to display the available text style names and the details of the current styles and
commands in the AutoCAD LT Text Window.

Note
With the help of the Style option of the TEXT command, you can select a text style from an
existing list. If you want to create a new style, use the STYLE command, which is explained later
in this chapter.

Figure 7-27  Writing text using the Right, Top-Left, Top-Center, and
Top-Right options
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ENTERING SPECIAL CHARACTERS
In almost all drafting applications, you need to draw special characters (symbols) in the normal
text and in the dimension text. For example, you may want to draw the degree symbol (º) or the
diameter symbol (ø), or you may want to underscore or overscore some text. This can be achieved
with the appropriate sequence of control characters (control code). For each symbol, the control
sequence starts with a percent sign written twice (%%). The character immediately following the
double percent sign depicts the symbol. The control sequences for some of the symbols are
given next.

Control sequence          Special character
%%c Diameter symbol (ø)
%%d Degree symbol (º)
%%p Plus/minus tolerance symbol (±)
%%o Toggle for overscore mode on/off
%%u Toggle for underscore mode on/off
%%% Single percent sign (%)

For example, if you want to draw 25º Celsius, you need to enter 25%%dCelsius. If you enter
43.0%%c, you get 43.0ø on the drawing screen. To underscore (underline) text, use the %%u
control sequence followed by the text to be underscored. For example, to underscore the text:
UNDERSCORED TEXT IN AUTOCAD LT, enter %%uUNDERSCORED TEXT IN
AUTOCAD LT at the prompt asking for text to be entered. To underscore and overscore a text
string, include %%u%%o at the text string.

Note
The special characters %%o and %%u act as toggles. For example, if you enter “This
%%utoggles%%u the underscore”, the word toggles will be underscored (toggles).

None of these codes will be translated in the TEXT command until this command is complete.
For example, to draw the degree symbol, you can enter %%d. As you are entering these symbols,
they will appear as %%d on the screen. After you have completed the command and pressed
ENTER, the code %%d will be replaced by the degree symbol (º).

You may be wondering why a percent sign should have a control sequence when a percent sign
can easily be entered at the keyboard by pressing the percent (%) key. The reason is that sometimes
a percent symbol is immediately followed (without a space) by a control sequence. In this case,
the %%% control sequence is needed to draw a single percent symbol. To make the concept
clear, assume you want to draw 67%±3.5. Try drawing this text string by entering 67%%%p3.5.
The result will be 67%p3.5, which is wrong. Now enter 67%%%%%p3.5 and notice the result on
the screen. Here you obtain the correct text string on the screen, that is, 67%±3.5. If there were
a space between 67% and ±3.5, you could enter 67% %%p3.5 and the result would be 67% ±3.5.

In addition to the control sequences shown earlier, you can use the %%nnn control sequence to
draw special characters. The nnn can take a value in the range of 1 to 126. For example, to draw
the & symbol, enter the text string %%038.
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CREATING MULTILINE TEXT*

You can use the MTEXT command (Figure 7-28) to write
a multiline text whose width can be specified by defining
two corners of the text boundary or by entering a width,
using the coordinate entry. The text created by the
MTEXT command is a single object regardless of the
number of lines it contains.

Note
When you invoke the MTEXT command, a sample text is attached to the cursor. By default, the
text “abc” is attached to the cursor. The MTJIGSTRING system variable stores the default
contents of the sample text. You can specify a string of ten alphanumeric characters as the default
sample text.

After specifying the width, you have to enter the text in the In-Place Text Editor. The prompt
sequence is given next.

Command: MTEXT �
Current text style: “Standard”. Text height: 0.2000
Specify first corner: Select a point to specify first corner.
Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]: Select an option
or select a point to specify other corner.

After selecting the first corner, you can move the pointing device so that a box that shows the
location and size of the paragraph text is formed. An arrow is displayed within the boundary,
that indicates the direction of the text flow. When you define the text boundary, it does not mean
that the text paragraph will fit within the defined boundary. AutoCAD LT only uses the  width of
the defined boundary as the width of the text paragraph. The height of the text boundary has no
effect on the text paragraph. Once you have defined the boundary of the paragraph text,
AutoCAD LT displays the In-Place Text Editor, as shown in Figure 7-29.

Note
Although the box boundary that you specify controls the width of the paragraph, a single word is
not broken to adjust inside the boundary limits. This means that if you write a single word whose
width is more than the box boundary specified, AutoCAD LT will write the word irrespective of
the box width, and therefore, will exceed the boundary limits.

The In-Place Text Editor consists of the Text formatting toolbar, Text window (with a ruler at
the top), and Options shortcut menu. The following is the description of the options in the
Text formatting toolbar and the Options shortcut menu.

Toolbar: Draw, Text > Multiline Text
Tool Palette: Command Tools > MText
Menu: Draw > Text > Multiline Text
Command: MTEXT

Figure 7-28  Invoking the Multiline
Text from the Draw toolbar
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Text Formatting Toolbar
The options under this toolbar are as follows.

Style
The Style drop-down list is the first drop-down list on the left in the Text Formatting toolbar.
This drop-down list contains a list of all the text styles created in the current drawing. You can
select the desired text style from this drop-down list. You can create a new text style using the
STYLE command, which is explained later in this chapter.

Font
The Font drop-down list displays all the fonts in
AutoCAD LT. You can select the desired font from
this drop-down list, see Figure 7-30.

Note
Irrespective of the font assigned to a text style,
you can assign a different font to that style
for the current multiline text using the Font
drop-down list.

Text Height
The Text Height edit box is used to specify the text height of the multiline text. The default
value in this edit box is 0.2000. Once you modify the height, AutoCAD LT retains that value
unless you change it. Remember that the MTEXT height does not affect the height specified for
the TEXT command.

Bold, Italic, Underline
You can use the appropriate tool buttons on the text box to make the selected text boldface, or
italics, or create underlined text. Boldface and italics are not supported by SHX fonts and hence
will not be available for the particular fonts. These three buttons toggle between on and off.

Figure 7-29  The In-Place Text Editor

 Figure 7-30  The Font drop-down list
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Undo
The Undo button allows you to undo the actions in the In-Place Text Editor. You can also press
the CTRL+Z keys to undo the previous actions.

Redo
The Redo button allows you to redo the actions in the In-Place Text Editor. You can also press
the CTRL+Y keys to redo the previous actions.

Stack
To create a fraction text, you must use the stack button with special characters /, ̂ , and #. The
character / stacks the text vertically with a line, and the character ^ stacks the text vertically
without a line (tolerance stack). The character # stacks the text with a diagonal line. After you
enter the text with the required special character between them, select the text, and then select
the Stack/Unstack button. The stacked text is displayed equal to 70 percent of the actual height.
If you enter two numbers separated by / or ̂  and then press the ENTER key or the SPACEBAR,
AutoCAD LT displays the AutoStack Properties dialog box, as shown in Figure 7-31. You can
use this dialog box to control the stacking properties.

Color
The Color drop-down list is used to set the color for the multiline text. You can also select the
color from the Select Color dialog box that is displayed by selecting Select Color in the
drop-down list.

Ruler
This button is used to turn on or off the display of ruler in the Text Window.

 Figure 7-31  The AutoStack Properties dialog box
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Left
This button is used to left align the text written in the Text Window.

Center
This button is used to center align the text written in the Text Window.

Right
This button is used to right align the text written in the Text Window.

Top
This button is used to top align the first row of the text written in the Text Window.

Middle
This button is used to middle align the text written in the Text Window.
Bottom
This button is used to bottom align the last row of the text written in the Text Window.

Numbering
This button is used to assign numbers (numerics like 1,2,3,....) to each row of the multiline text.

Bullets
This button is used to assign bullets to each row of the multiline text.

Uppercase Letters
This button is used to assign upper case alphabets to each row of the multiline text.

Uppercase
When you select text in the text editor and choose this button, the alphabets written in the
lowercase are converted to the uppercase.

Insert Field
AutoCAD allows you to insert a field in the multiline text. The field contains data that is associative
to the property that defines the field. For example, you can insert a field that has the name of the
author of the current drawing. If you have already defined the author of the current drawing in
the Drawing Properties dialog box, it will be automatically displayed in the field. If you modify
the author and update the field, the changes are automatically made in the text. When you
choose this option, the Field dialog box is displayed, as shown in Figure 7-32. You can select the
field to be added from the Field names list box and define the format of the field using the
Format list box. Choose OK after selecting the field and format. If the data in the selected field
is already defined, it will be displayed in the Text window. If not, the field will display dashes
(----).
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Note
To update a field after the text of that field is modified, double-click on the multiline text to
display the In-Place Text Editor. Click on the field in the Text window to select it and then
right-click to display the shortcut menu. Choose Update Field from this menu; the field will be
updated. You can also edit the field or convert it into text using the same shortcut menu.

Lowercase
Choosing this button converts the alphabets written in the uppercase to the lowercase.

Overline
Choosing this button forces an overline on the  top of text. You can also select the existing text
and then choose this button to place a line on top of it.

Symbol
This option is used to insert the special characters in the text. When you choose Symbol button
from the Text Formatting toolbar, a shortcut menu (Figure 7-33) appears that displays some
predefined special characters. You can also choose Other from the shortcut menu to display the
Character Map dialog box. This dialog box has a number of other special characters that you
can insert in multiline text. To insert the characters from the dialog box, select the character you
want to copy and then choose the Select button. Once you have selected all the required
special characters, choose the Copy button and then close the dialog box. Now, in the Text

Figure 7-32  The Field dialog box
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window, position the cursor where you want to insert the
special characters and right-click to display the shortcut
menu. Choose Paste to insert the selected special character
in the In-Place Text Editor.

Oblique Angle
This option is used to specify the slant angle for the text.
Enter the angle in the Oblique Angle edit box or use
spinner to specify the slant angle, which is measured from
the positive direction of the X-axis, in the clockwise
direction.

Tracking
This option is used to control the spacing between the
selected characters. Select the characters and specify the
value of the spacing in the Tracking edit box. You can also
use the Tracking spinner to specify this value. The default
tracking value is 1.000. You can specify values ranging from
0.7500 to 4.0000.

WIdth Factor
This option is used to control the width of characters. By
default, the value is set to 1.000. Select the characters and
use the Width Factor edit box or the Width Factor spinner
to specify the width of the characters.

Text Window
The Text window is used to enter the multiline text. The width of the active text area is determined
by the width of the window that you specify when you invoke the MTEXT command. You can
increase the size of the dialog box by dragging the right or the bottom edge of the text window.
You can also use the scroll bar to move up or down to display the text.

The ruler on the top of the text window is used to specify the indentation of the current paragraph.
The top slider of the ruler specifies the indentation of the first line of the paragraph while the
bottom slider specifies the indentation of the other lines of the paragraph.

Options Shortcut Menu
The Options shortcut menu provides various options to edit the multiline text. To edit the text,
select it and then choose the Options button form the Text Formatting toolbar. The shortcut
menu (Figure 7-34) is displayed. The various options are discussed next.

Show Toolbar
This option is used to control the visibility of the Text Formatting toolbar.

Figure 7-33  Shortcut menu invoked
when you choose the Symbol button
from the Text Formatting toolbar
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Show Options
This option is used to control the visibility of the advanced options
in the Text Formatting toolbar. If this option is not selected, the
second row of buttons will not be available in the Text Formatting
toolbar.

Show Ruler
The Show Ruler option is used to control the visibility of the
Ruler in the Text Formatting Window.

Opaque Background
Select this option to make the background of the Text Window
opaque. By default, the background is transparent. The effect of
the background (opaque/transparent) will be more visible if the
text window is invoked with some entities existing in the drawing
window.

Import Text
When you choose this option, AutoCAD LT displays the Select
File dialog box. In this dialog box, you can select any text file you
want to import as the multiline text. The imported text is displayed
in the text area. Note that only the ASCII or RTF files are
interpreted properly.

Indents and Tabs
The Indents and Tabs option allows you to set the indentation of the multiline text and the tab
position. Note that as mentioned earlier, these options can also be set using the ruler and the
sliders available on top of the drawing window. When you choose Indents and Tabs from the
shortcut menu, the Indents and Tabs dialog box is displayed, as shown in Figure 7-35. The
various options in the dialog box are discussed next.

Figure 7-34  The Options
shortcut menu

Figure 7-35  The Indents and Tabs dialog box
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Indentation Area. You can set the indentation for the first line and the following lines of the
multiline text by entering the values in the First Line and the Paragraph edit boxes.

Tab stop position Area. The Tab stop position area is used to set the position up to which the
cursor will move when you press the TAB key once at the starting of a new paragraph. This
position is called the tab position. To set the tab position, enter the value in the edit box in this
area and then choose the Set button. You will notice that the value appears in the list box below
this area. You can choose the Clear button to
delete the selected tab position value. Notice
that a mark appears in the ruler that defines
the tab stop position.

Background Mask
This option is used to define a background
color for the multiline text. When you choose
this option, the Background Mask dialog box
is displayed, as shown in Figure 7-36. To add
a background mask, select the Use background
mask check box and select the required color
from the drop-down list in the Fill Color area. You can set the size of the colored background
behind the text using the Border offset factor edit box. The box that defines the background
color will be offset from the text by the value you define in this edit box. The value in this edit
box is based on the height of the text. If you enter 1 as the value, the height of the colored
background will be equal to the height of the text and will extend through the length of the
window defined to write the multiline text. Similarly, if you enter 2 as the value, the height of the
colored box will be twice the height of the text and will be equally offset above and below the
text. However, the length of the colored box will still be equal to the length of the window
defined to write the multiline text. You can select the Use background check box in the Fill
Color area to use the color of the background of the drawing area to add the background mask.

Justification
In large complicated technical drawings, the Justification option is used to fit the text matter
with a specified justification and alignment. For example, if the text justification is bottom-right
(BR), the text paragraph will spill to the left and above the insertion point, regardless of how you
define the width of the paragraph. When you select Justification from the shortcut menu, a
cascading menu appears that displays the predefined text justifications. By default, the text is
Top Left justified. You can choose the new justification from the cascading menu. The various
justifications are TL, ML, BL, TC, MC, BC, TR, MR, BR. Figure 7-37 shows various text
justifications for multiline text.

Find and Replace
When you choose this option, the Find and Replace dialog box is displayed, as shown in
Figure 7-38. The options available in this dialog box are discussed next.

Find what. You can define the text string that you need to find in this text box. You can locate
a part of a word or the complete word mentioned in this text box.

Figure 7-36  The Background Mask dialog box
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Replace with. If you want some text to be replaced, enter new text for replacement in this text
box.

Match whole word only. If this check box is selected, AutoCAD LT will match the word in the
text only if it is a single word identical to that mentioned in the Find what text box. For
example, if you enter and in the Find what text box and select the Match whole word only
check box, AutoCAD LT will not match the string and in words like sand, land, band, and so
on.

Match case. If this check box is selected, AutoCAD LT will find the word only if the cases of all
the characters in the word are identical to that of the word mentioned in the Find what text box.

   Figure 7-37  Text justifications for MTEXT (P1 is the text insertion point)

Figure 7-38  The Find and Replace dialog box
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Find Next. Choose this button to continue the search for the text entered in the Find what box.

Replace. Choose this button to replace the highlighted text with the text entered in the Replace
with text box.
Replace All. If you choose this button, all the words in the current multiline text that match the
word specified in the Find what text box will be replaced with the word entered in the Replace
with box.

Select All
This option is used to select the complete text entered in the Text window.

Change Case
This option is used to change the case of the selected text to uppercase or lowercase.

AutoCAPS
If you choose this option, the case of all the text written or imported after choosing this option
will be changed to uppercase. However, the case of the text written before choosing this option
is not changed.

Remove Formatting
This option is used to remove the formatting such as bold, italics, or underline from the selected
text. To use this option, select the text whose formatting you need to change and then right-click
to display the shortcut menu. In the menu, choose the Remove Formatting option. The formatting
of the selected text will be removed.

Combine Paragraphs
This option is used to combine the selected paragraphs into a single paragraph. AutoCAD LT
replaces the returns between all the paragraphs by a space. As a result, the lines in the resultant
paragraph are in continuation.

Character Set
This option is used to define the character set for the current font. You can select the desired
character set from the cascading menu that is displayed when you choose this option.

Stack
Note that this option is available only if you select stack characters from the text. The Stack
option is used to stack the selected text if there are any stack characters (characters separated by
/, #, or ^) available in the multiline text.

Unstack
This option is also available only if there are some stacked characters in the text. The Unstack
option is used to unstack the selected stacked text.
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Properties
This option is available only when you select a
stacked text. When you choose this option, the
Stack Properties dialog box is displayed, as shown
in Figure 7-39. This dialog box is used to edit the
text and the appearance of the selected stacked
text. The options in this dialog box are discussed
next.

Text Area. You can change the upper and the lower
values of the stacked text by entering their values
in the Upper and Lower text boxes, respectively.

Appearance Area. You can change the style, position, and size of the stacked text by entering
their values in the Style, Position, and Text size text boxes, respectively.
Default. This option allows you to restore the default values or save the new settings as the
default settings for the selected stacked text.

AutoStack. When you choose this button, the AutoStack Properties dialog box is displayed,
same as that shown earlier in Figure 7-31. The options in this dialog box were discussed under
the Stack heading.

Tip
The options in the Options shortcut menu are also available in the shortcut menu that is
displayed when you select the text in the Text window and right-click. The shortcut menu is
shown in Figure 7-40.

Note
The Undo and the Redo options are used to undo or redo the last actions done in the In-Place
Text Editor. The Cut and Copy options can be used to move or copy the text from the text editor
to any other application. Similarly, using the Paste option, you can paste text from any windows
text-based application to the In-Place Text Editor.

Figure 7-39  The Stack Properties dialog box
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In this example, you will use the In-Place Text Editor dialog box to write the following text in
the drawing window.

For long, complex entries, create multiline text using the MTEXT option. The angle
is 10-degree. Dia = 1/2” and length = 32 1/2”.

The font of the text is Swis721 BT, text height is 0.20, color red, and written at an angle of
10-degree with Middle-Left justification. Make the word “multiline” bold, underline the text
“multiline text”, and make the word “angle” italic. The line spacing type and line spacing
between the lines are At least and 1.5x respectively. Use the symbol for degrees. After writing
the text in the Text window, replace the word “option” with “command”.

1. Choose the Multiline Text button from the Draw toolbar. After invoking the command,
specify the first corner on the screen to define the first corner of the paragraph text boundary.
You need to specify the rotation angle of the text before specifying the second corner of the
paragraph text boundary. The prompt sequence is given next.

Example 1 General

Figure 7-40  Shortcut menu
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Current text style: STANDARD. Text height: 0.2000
Specify first corner: Select a point to specify first corner.
Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]: R �
Specify rotation angle <0>: 10.
Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]: L �
Enter line spacing type [At least/Exactly] <At least>: �
Enter line spacing factor or distance <1x>: 1.5x
Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]: Select another
point to specify the other corner.

The In-Place Text Editor is displayed.

2. Select Swis721 BT true type font from the Font drop-down list.

3. Enter 0.20 in the Text height edit box, if the value in this edit box is not 0.2.

4. Select Red from the Color drop-down list.

5. Now enter the text in the In-Place Text Editor, as shown in Figure 7-41. To add the
degrees symbol, choose the Symbol button from the Text Formatting toolbar and select
Degrees from the shortcut menu. When you type 1/2 after Dia = and then press the ” key,
AutoCAD LT displays the AutoStack Properties dialog box. Select Convert it to a horizontal
fraction radio button, if it is not already selected. Also, make sure the Enable AutoStacking
check box is selected. Now, close the dialog box.

Figure 7-41  The In-Place Text Editor
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Similarly, when you type 1/2  after length = 32 1/2 and then press the ” key, AutoCAD LT
displays the AutoStack Properties dialog box. Select the Convert it to a diagonal fraction
radio button. Close the dialog box.

6. Double-click on the word “multiline” to select it (or pick and drag to select the text) and
then choose the Bold button to make it boldface and the Underline button to underline it.

7. Similarly, highlight the word “text” and choose the Underline button to underline it.

8. Highlight the word “angle” by double-clicking on it and then choose the Italic button.

9. Right-click in the Text window and choose Justification > Middle Left from the shortcut
menu.

10. Click at the start of the multiline to move the cursor to the start. Now, right-click on the text
window and choose Find and Replace from the shortcut menu. Alternatively, you can use
CTRL+R keys or choose Find and Replace from the Options shortcut menu. On doing so,
the Find and Replace dialog box is displayed.

11. In the Find what edit box, enter option and in the Replace with edit box, enter command.

12. Choose the Find Next button. AutoCAD LT finds the word “option” and highlights it .
Choose the Replace button to replace option by command. The AutoCAD LT information
box is displayed informing you that AutoCAD LT has finished searching for the word.
Choose OK to close the information box.

Note
To set the width of multiline text objects, hold and drag the arrowhead on the right side of the
ruler. In this example, the text has been accomodated in two lines.

13. Now, choose Cancel to close the Find and Replace dialog box and return to the In-Place
Text Editor. Choose the OK button to exit the In-Place Text Editor. The text is displayed
on the screen as shown in Figure 7-42.

Tip
The text in the In-Place Text Editor can be selected by double-clicking on the word, by
holding down the left mouse button of the pointing device and then dragging the cursor, or by
triple-clicking on the text to select the entire line or paragraph.

Figure 7-42  Multiline text for Example 1
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Write the text on the screen, as shown in Figures 7-43 and 7-44. Use the special characters and
text justification options shown in the drawing, using the TEXT and MTEXT commands. The
text height is 0.1 and 0.15 for Figures 7-43 and 7-44, respectively.

EDITING TEXT
The contents of MTEXT and TEXT object can be edited by using the DDEDIT and
PROPERTIES commands. You can also use the AutoCAD LT editing commands, such as
MOVE, ERASE, ROTATE, COPY, MIRROR, and GRIPS with any text object.

In addition to editing, you can also modify the text in AutoCAD LT. The modification that you
can perform on the text include changing its scale and justification. The various editing and
modifying operations are discussed next.

Editing Text Using the DDEDIT Command

You can use the DDEDIT command to edit the text. The most convenient way of invoking
this command is by double-clicking on the text. If you double-click on the single line
text written using the TEXT command, AutoCAD LT displays the In-Place Text Editor

for single line text, in which the selected text is displayed. You can modify the text string in this
edit box. The size of the bounding box increases or decreases, as you add more text or remove
the existing text. Note that for the text object, you cannot modify any of its properties in the
bounding box. However, if you double-click on the multiline text written using the MTEXT
command, AutoCAD LT displays the text in the In-Place Text Editor for multiline text. You can
make the changes using the various options in the editor. Apart from changing the text string,
you are also allowed to change the properties of the paragraph text.

Figure 7-43  Drawing with special characters Figure 7-44  Drawing for Exercise 2

Exercise 2 General

Toolbar: Text > Edit
Menu: Modify > Object > Text > Edit
Command: DDEDIT
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You can also invoke the Edit Text dialog box and the In-Place Text Editor from the shortcut
menu. Select the text for editing and then right-click in the drawing area. A shortcut menu is
displayed and depending on the text object you have selected, the Text Edit or Mtext Edit
options are available in the menu. Selecting these options displays the respective dialog boxes.

Editing Text Using the PROPERTIES
Palette
Using the DDEDIT command with the text object, you can only
change the text string and not its properties such as the height,
angle, and so on. In this case, you can use the PROPERTIES
palette for changing the properties. Select the text and choose
the Properties button in the Standard toolbar. AutoCAD LT
displays the PROPERTIES palette with all the properties of
the selected text, as shown in Figure 7-45. Here you can change
any value and also the text string. To edit a single line text, you
can change the text string in the window. But for a multiline
text, you must choose the Full editor button in the Content edit
box. AutoCAD LT automatically switches to the In-Place
Text Editor, where you can make changes to paragraph text.

Modifying the Scale of the Text

You can modify the scale factor of the text using the Scale Text button in the Text
toolbar. AutoCAD LT uses one of the justification options as the base point to scale the
text. The prompt sequence that follows when you invoke this tool is given next.

Select objects: Select the text object to scale
Select objects: �
Enter a base point option for scaling
[Existing/Left/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR] <current>: Specify
an option that will be used as the base point to scale the text.
Specify new height or [Match object/Scale factor] <0.2000>: Enter the new height or select an
option

Match object
You can use the Match object option to select an existing text whose height will be used to scale
the selected text.

Scale factor
You can use the Scale factor option to specify a scale factor to scale the text. You can also use the
Reference option to specify the scale factor for the text.

Toolbar: Text > Scale
Menu: Modify > Object > Text > Scale
Command: SCALETEXT

Figure 7-45   The PROPERTIES
palette
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Toolbar: Text > Justify
Menu: Modify > Object > Text > Justify
Command: JUSTIFYTEXT

Modifying the Justification of the Text

You can modify the justification of the text using the Justify Text button in the Text
toolbar. Note that even after modifying the justification using this command, the location
of the text is not changed. The prompt sequence that follows when you invoke this tool

is given next.

Select objects: Select the text object whose justification needs to be changed
Select objects: �
Enter a justification option
[Left/Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR] <Left>: Specify the
new justification for the text.

INSERTING TABLE IN THE DRAWING

A number of mechanical, architectural, electric, or civil drawings require a table in
whch some information about the drawing is displayed.For example, a drawing of an
assembly needs the Bill of Material, which is a table providing details such as the number

of parts in the drawing, their names, their material, and so on. To enter this information,
AutoCAD LT allows you to create tables using the TABLE command. When you invoke this
command, the Insert Table dialog box is displayed, as shown in Figure 7-46. The options in
this dialog box are discussed next.

Table Style Settings Area
The options in this area are used to define the settings for the table style. These options are
discussed next.

Table Style name
This drop-down list displays the names of the various table styles in the current drawing. By
default, it displays only Standard. This is the default table style in a drawing.

Table Style dialog
This button is chosen to display the Table Style dialog box that can be used to create a new table
style, or modify and delete an existing table style. You can also use this dialog box to set a table
style current. You will learn more about creating a new table style in the next section.

Toolbar: Draw > Table
Menu: Draw > Table
Command: TABLE
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Insertion Behavior Area
The options in this area are used to specify the method of placing the table in the drawing.
These options are discussed next.

Specify insertion point
This radio button is selected to place the table using the upper left corner of the table. If this
radio button is selected and you choose OK from the Insert Table dialog box, you will be
prompted to select the insertion point, which is by default the upper left corner of the table. By
creating a different table style, you can change the point using which the table is inserted.

Specify window
If this radio button is selected and you choose OK from the Insert Table dialog box, you will be
prompted to specify two corners for placing the table. The number of rows and columns in the
table will depend on the size of the window you define. When you choose OK from the Insert
Table dialog box after selecting this radio button, you will be prompted to select the first and the
second corner. Depending on the size of the window defined by the two corner, the number and
size of rows and columns are defined.

Column and Row Settings Area
The options in this area are used to specify the number and size of rows and columns. The
availability of these options depend on the option selected from the Insertion Behavior area.
These options are discussed next.

Figure 7-46  The Insert Table dialog box
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Columns
This spinner is used to specify the number of columns in the table.

Column width
This spinner is used to specify the width of columns in the table.

Data Rows
This spinner is used to specify the number of rows in the table.

Row Height
This spinner is used to specify the height of rows in the table. The height is defined in terms of
lines and the minimum value is one line.

After setting the parameters in the Insert Table dialog box, choose the OK button. Depending
on the type of insertion behavior selected, you will be prompted to insert the table. As soon as
you complete the insertion procedure, the In-Place Text editor is displayed and you are allowed
to enter the parameters in the first row of the table. By default, the first row is the title of the
table. After entering the data, press ENTER. The first field of the first column is highlighted,
which is the column head, and you are allowed to enter the data in it.

AutoCAD LT allows you to use the arrow keys on the keyboard to move to the other cells in the
table. You can enter the data in the field and then press the arrow key to move to the other cells
in the table. After entering the data in all the fields, press ENTER to exit the Text Formatting
toolbar.

Tip
You can also right-click while entering the data in the table to display the shortcut menu. This
shortcut menu is similar to that shown in the In-Place Text Editor and can be used to insert
field, symbols, text, and so on.

CREATING A NEW TABLE STYLE

To create a new table style, choose the Table Style Manager button from the Styles
toolbar; the Table Style dialog box is displayed, as shown in Figure 7-47. You can also
invoke this dialog box by choosing the Table Style Dialog button [...] from the Insert

Table dialog box.

To create a new table style, choose the New button, the Create New Table Style dialog box will
be displayed, as shown in Figure 7-48.

Enter the name of the table style in the New Style Name edit box. Select the style on which you

Toolbar: Styles > Table Style
Menu: Format > Table Style
Command: TABLESTYLE



7-44                                                                                              AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

want to base the new style from the Start With drop-down list. By default, this drop-down list
shows only Standard. After specifying the settings, choose Continue; the New Table Style
dialog box will be displayed. This dialog box has three tabs, which are discussed next.

Data Tab
The options available in the Data tab, shown in Figure 7-49, are used to specify the settings for
the data to be entered in the cells of the table, cell border properties, table direction, and the
margins between the data and border of the cells. These options are discussed next.

Cell properties Area
The options in this area are used to set the properties for the style, color, height, and alignment
of the text in the cells. These options are discussed next.

Figure 7-47  The Table Style dialog box

Figure 7-48   The Create New Table Style dialog box
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Text style. This drop-down list is used to select the text style that will be used to enter the text
in the cells. By default, it shows only Standard, which is the default text style. You will learn to
create more text styles later in this chapter.
Text height. This edit box is used to specify the height of the text to be entered in the cells.

Text color. This drop-down list is used to specify the color of the text that will be entered in the
cells. If you select the Select Color option, the Select Color dialog box is displayed, which can
be used to select from index color, true color, or from the color book.
Fill color. This drop-down list is used to specify the fill color for the cells.

Alignment. This drop-down list is used to specify the alignment of the text that will be entered
in the cells. The default alignment is top center.

Border properties Area
The options in this area are used to set the properties of the border of the table. The lineweight
and color settings that you specify using this area will be applied to all borders, outside borders,
inside borders, no border, or bottom border, depending on which button is chosen from this
area. The two drop-down lists in this area are discussed next.

Figure 7-49  The Data tab of the New Table Style dialog box
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Grid lineweight. This drop-down list is used to specify the lineweight of the border that you
specify using the buttons in this area.

Grid color. This drop-down list is used to specify the color of the border that you specify using
the buttons in this area.

Column Heads Tab
The options available in the Column Heads tab, shown in Figure 7-50, are used to specify the
settings for the data to be entered in the column heads of the table and the border properties of
the column heads. These options will be available only if the Include Header row check box in
the Cell properties area is selected. These options are similar to those discussed in the Data tab.

Title Tab
The options in the Title tab, shown in Figure 7-51, are used to specify the settings for the data
to be entered in the title of the table and the border properties of the table. These options will be
available only if the Include Title row check box in the Cell properties area is selected. These
options are similar to those discussed in the Data tab.

Figure 7-50  The Column Heads tab of the New Table Style dialog box
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Figure 7-51  The Title tab of the New Table Style dialog box

General Area
This area has the Table direction drop-down list, which is used to specify the direction of the
table. The default direction is down. As a result, the title and headers are at the top and the data
fields are below them. If you select Up from the Table direction drop-down list, the title and
headers will be at the bottom and the data fields will be on the top.

Cell margins Area
The options in this area are used to set the margins between the data in the cells and the
horizontal and vertical borders. These options are discussed next.

Horizontal
This edit box is used to specify the minimum spacing between the data entered in the cells and
the left and right border lines of the cells.

Vertical
This edit box is used to specify the minimum spacing between the data entered in the cells and
the top and bottom border lines of the cells.



7-48                                                                                              AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

SETTING A TABLE STYLE CURRENT
To set a table style current so that it is used to create all the new tables, invoke the Table Style
dialog box by choosing the Table Style Manager button from the Styles toolbar. Select the table
style from the Styles list box in the Table Style dialog box and choose the Set Current button.
The current table style on top of the Table Style dialog box now displays the name of the table
style you made current. You can also set a table style current by selecting it from the Table Style
Control drop-down list in the Styles toolbar. This is a more convenient method of setting a table
style current.

MODIFYING A TABLE STYLE
To modify a table style, invoke the Table Style dialog box by choosing the Table Style Manager
button from the Styles toolbar. Select the table style from the Styles list box in the Table Style
dialog box and choose the Modify button. The Modify Table Style dialog box is displayed.
This dialog box is similar to the New Table Style dialog box. Modify the options in the various
tabs and areas of this dialog box and then choose OK.

MODIFYING  TABLES
Select any cell of a table and right-click to display a shortcut
menu, as shown in Figure 7-52. The options in the shortcut
menu are used to Modify the table, insert block, add formulas
and perform other  operations. The Cut and Copy options
can be used to move or copy the contents from one cell to the
other. Using the Paste option, you can paste the contents that
you have cut or copied from one cell to the other. Place the
cursor on the Recent Input option; a flyout, that contains
the recent command inputs, is displayed. The options available
in the shortcut menu are discussed next.

Cell Alignment
Choose the Cell Alignment option from the shortcut menu to
display a flyout. The options in the flyout are used to align the
contents of cells. These options are similar to the justification
options of multiline texts.

Cell Borders
Choose the Cell Borders option to display the Cell Border
Properties dialog box, see Figure 7-53. The options in this
dialog box are similar to those in the Border Properties Area
of Data Tab in the New Table Style dialog box.

Match Cells
This option is used to inherit the properties of one cell into the other. For example, if you have
specified Top Left Cell Alignment to the source cell, then using the Match Cells option, you

Figure 7-52  The shortcut menu
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can inherit this property to the destination cell. This option is useful if you have assigned a
number of properties to one cell and you want to inherit these properties in some specified
number of cells. Choose the Match Cell option from the shortcut menu; the cursor is changed to
the match properties cursor and you are prompted to select the destination cell. Select the cells,
in which you want the properties to be inherited and then press ENTER.

Insert Block
This option is used to insert a block in the
selected cell. Choose the Insert Block option;
Insert a Block in a Tabel Cell dialog box is
displayed, as shown in Figure 7-54. Enter the
name of the block in the Name edit box or
choose the Browse button to locate the
destination file of the block. If you have
browsed the file path, it will be displayed in
the Path area. The options available in the
Insert a Block in a Tabel Cell dialog box are
discussed next.

Properties Area
The options in this area are discussed next.

Cell Alignment. This drop-down list is used
to define the block alignment in the selected cell.

Scale. This drop-down list is used to specify the scale of the block. By default, this edit box is
not available because the AutoFit check box is selected below this drop-down list. Selecting the
AutoFit check box ensures that the block is scaled such that it fits in the selected cell.

Figure 7-53  The Cell Border Properties dialog box

Figure 7-54  The Insert a Block in a Tabel Cell
dialog box
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Rotation angle. The Rotation angle edit box is used to specify the angle by which the block
will be rotated before being placed in the cell.

Insert Formula
Place the cursor on the Insert Formula option to
display the Insert Formula flyout. The flyout is shown
in Figure 7-55. This flyout contains the formulas that
can be applied to a given cell. The formula calculates
the values for that cell using the values of other cell. In
a table, the columns are named with letters (like A, B,
C, .......) and rows are named with numbers (like 1, 2,
3, .......). The TABLEINDICATOR system variable
controls the display of column letters and row numbers.
By default, TABLEINDICATOR system variable is set to 1, that means the row numbers and
column letters will be displayed when In-Place Text Editor is invoked. Set the system variable to
zero to turn off the visibility of row numbers and column letters. The nomenclature of cells is
done using the column letters and row numbers.   For example, the cell corresponding to
column A and row 2 is A2. For a better understanding, some of the cells have been labeled
accordingly in Figure 7-56.

Formulas are defined by the range of cells. The range of cells is specified by writing the first and
the last cell of the range, separated by a colon (:). The range takes all the cells falling between
specified cells. For example, if you write A2 : C3, this means all the cells falling in 2nd and 3rd
rows, Column A and B will be taken into account. To insert a formula, double click on the cell;
In-Place Text Editor is invoked. You can now write the syntax of the formula in the cell. The
syntax for different formulas are discussed later while explaining different formulas. Formulas
can also be inserted by using the Insert Formula flyout, shown in Figure 7-55. Different formulas
available in the Insert Formula flyout are discussed next.

Figure 7-56  The Table showing nomenclature for Columns, Rows, and Cells

Figure 7-55   The Insert Formula flyout
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Sum
The Sum option gives the output for a given cell as the sum of the numerical values entered in
a specified range of cells. Invoke the shortcut menu by selecting the cell, in which you want to
insert the formula and then right click. Choose the Sum option from the shortcut menu. You are
prompted to select the first corner of the tabel cell range and then the second corner. The sum
of values of all the cells that fall between the selected range will be displayed as the output. As
soon as you specify the second corner, In-Place Text Editor is displayed and  also the formula
is displayed in the cell. In addition to the formula, you can also write multilne text  in the cell.
Choose the Ok button to exit the editor. When you exit the text editor, the formula is replaced
by a hash (#). Now, if you enter numerical values in the cells included in the range, the hash (#)
is replaced according to the addition of those numerical values. The prompt sequence, when
you select the Sum option, is given next.

Select first corner of table cell range: Specify a point in the first cell of the cell range.
Select second corner of table cell range: Specify a point in the last cell of the cell range

Note
Syntax for Sum option is: =Sum(Number of first cell of cell range (for example: A2):Number of
last cell of cell range (for example: C5))

Average
This option is used to insert a formula, that calculates the average of values of the cells falling in
the cell range. Prompt sequence is the same as for the Sum option.

Note
Syntax for Average option is: =Average(Number of first cell of cell range (for example: A2):Number
of last cell of cell range (for example: C5))

Count
This option is used to insert a formula that calculates the number of cells falling under the cell
range. The prompt sequence is the same as for the Sum option.

Note
Syntax for Count option is: =Count(Number of first cell of cell range (for example: A2):Number
of last cell of cell range (for example: C5))

Cell
This option equates the current cell with the selected cell. Whenever there is a change in the
value of the selected cell, the change is automatically updated in the other cell. Select the Cell
option from the shortcut menu; you are prompted to select a table cell. Select a cell with which
you want to equate the current cell. The prompt sequence for the Cell option is given next.

Select table cell: Select a cell to equate with the current cell
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Note
Syntax for Cell option is: =Number of the cell

Equation
Using this option, you can manually write equations. The syntax for writing the equations
should be the same as explained earlier.

Edit Cell Text
This option is used to edit cell text using In-Place Text Editor.

Insert Columns
This option is used to insert a column in the table. Choose the Insert Columns option to
display the Insert Column flyout. Two options are available in the flyout. Choose the Right
option to add a new column on the right side of the selected cell. Choose the Left option to add
a column on the left side of the selected cell.

Delete Columns
Choose this option to delete the column corresponding to the selected cell.

Size Columns Equally
This option is highlighted only when you have done multiple selections of cells. Use the SHIFT
key to select multiple cells and then choose the Size Columns Equally option from the shortcut
menu to make the size of all the selected columns equal. To do so, select the table by clicking
anywhere on the table boundaries. Now invoke the shortcut menu and choose the Size Columns
Equally option.

Insert Rows
This option is used to insert a row in the table. When you choose this option, the Insert Rows
flyout is displayed. Two options are available in the flyout. Choose the Above option; a new row
will be added above the selected cell. Choose the Below option to add a row below the selected
cell.

Delete Rows
Select this option to delete the row corresponding to the selected cell.

Size Rows Equally
This option is used to make the selected rows equal in size. The procedure for making rows equal
in size is the same as that for Size Columns Equally.

Delete Cell Contents
Choose this option to delete all the contents including formulas from the selected cell. You can
also select the cell and choose DELETE from the keyboard to delete the contents of the cell.
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Merge Cells
This option is used to merge the cells. Place the cursor on the Merge Cells option; the Merge
Cells flyout is displayed. Three options are available in the flyout. Select multiple cells using the
SHIFT key and then select All from the flyout to merge all the selected cells. To merge all the
cells in the row of the selected cell, select the By Row option from the flyout. To merge all the
cells in the column of the selected cell, select the By Row option from the flyout.

SUBSTITUTING FONTS
AutoCAD LT provides you the facility to designate the fonts that you want to substitute for the
other fonts used in the drawing. The information about font mapping is specified in the font
mapping file (acad.fmp). The font mapping has the following advantages.

1. You can specify a font to be used when AutoCAD LT cannot find a font used in the drawing.

2. You can enforce the use of a particular font in the drawings. If you load a drawing that uses
different fonts, you can use font mapping to substitute the desired font for the fonts used in
the drawing.

3. You can use .shx fonts while creating or editing a drawing. When you are done and ready to
plot the drawing, you can substitute other fonts for .shx fonts.

The font mapping file is an ASCII file with FMP extension containing one font mapping per
line. The format on the line is given next.

Base name of the font file;Name of the substitute font with extension (ttf, shx, etc.)

For example, if you want to substitute the ROMANC font for SWISS.TTF; the entry is given
next.

SWISS;ROMANC.SHX

You can enter this line in the acad.fmp file or create a new file. To create a new font mapping file,
you need to specify this new file. You can use the Options dialog box to specify the new font
mapping file. To specify a font mapping table in the Options dialog box, choose Tools >
Options from the menu bar to display the Options dialog box. Choose the Files tab and click
on the plus sign next to Text Editor, Dictionary, and Font File Names. Now, click on the plus
sign next to Font Mapping File to display the path and the name of the font mapping file.
Double-click on the file to display the Select a file dialog box. Select the new font mapping file
and exit the Options dialog box. At the Command prompt, enter REGEN to convert the
existing text font to the font as specified in the new font mapping file. You can also use the
FONTMAP system variable to specify the new font map file.

Command: FONTMAP �
Enter new value for FONTMAP, or . for none <“path and name of the current font mapping
file”>: Enter the name of the new font mapping file.
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The following file is a partial listing of acad.fmp file with the new font mapping line added
(swiss;romanc.shx).

swiss;romanc.shx
cibt;CITYB___.TTF
cobt;COUNB___.TTF
eur;EURR____.TTF
euro;EURRO___.TTF
par;PANROMAN.TTF
rom;ROMANTIC.TTF
romb;ROMAB___.TTF
romi;ROMAI___.TTF
sas;SANSS___.TTF
sasb;SANSSB__.TTF
sasbo;SANSSBO_.TTF
saso;SANSSO__.TTF

Note
The text styles that were created using the PostScript fonts are substituted with an equivalent
TrueType font and plotted using the substituted font.

Specifying an Alternate Default Font
When you open a drawing file that specifies a font file that is not on your system or is not
specified in the font mapping file, AutoCAD LT, by default, substitutes the simplex.shx font file.
You can specify a different font file in the Options dialog box or do so by changing the FONTALT
system variable.

Command: FONTALT �
New value for FONTALT, or . for none <“simplex.shx”>: Enter the font file name.

CREATING TEXT STYLES

By default, text in AutoCAD LT is written using the default text style called Standard.
This text style is assigned a default text font (TXT.SHX) and the default formatting.
However, if you need to write a text using some other font and other parameters, you

need to use the In-Place Text Editor. This is because only using this command, you can change
the formatting and font of the text.

However, it is a very tedious job to use the In-Place Text Editor every time to write the text and
change its properties. This is the reason AutoCAD LT provides you with an option of modifying

Toolbar: Text > Text Style
Styles > Text Style

Menu: Format > Text Style
Command: STYLE
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the default text style or creating a new text style. After creating a new text, you can make it
current. All the text written after making the new style current will use this style.

To create a new text style or to modify the default style, choose the Text Style Manager button
from the Styles toolbar. The Text Style dialog box is displayed, as shown in Figure 7-57.

In the Style Name edit box the default style (Standard) will be displayed. For creating a new
style, choose the New button to display the New Text Style dialog box, as shown in Figure 7-58,
and enter the name of the style you want to create.

A new style having the entered name and the properties present in the Text Style dialog box
will be created. To modify this style, select the style name from the list box and then change the
different settings by entering new values in the appropriate boxes. You can change the font by
selecting a new font from the Font Name drop-down list. Similarly, you can change the text
height, width, and oblique angle.

 Figure 7-58  The New Text Style dialog box

Figure 7-57  The Text Style dialog box
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Remember that if you have already specified the height of the text in the Text Style dialog box,
AutoCAD LT will not prompt you to enter the text height while writing the text using the TEXT
command. The text will be created using the height specified in the text style. If you want
AutoCAD LT to prompt you for the text height, specify 0 text height in the dialog box. For
Width Factor, 1 is the default. If you want the letters expanded, enter a width factor greater than
1. For compressed letters, enter a width factor less than 1. Similarly, for the Oblique Angle, 0 is
the default. If you want the slant of the letters toward the right, the value should be greater than
0; to slant the letters toward the left, the value should be less than 0. You can also force the text
to be written upside down, backwards, and vertically by checking their respective check boxes.
As you make the changes, you can see their effect in the Preview box. After making the desired
changes, choose the Apply button and the Close button to exit the dialog box. Figure 7-59

shows text objects with all these settings.

DETERMINING TEXT HEIGHT
The actual text height is equal to the product of the scale factor and the plotted text height.
Therefore, scale factors are important numbers for plotting the text at the correct height. This
factor is a reciprocal of the drawing plot scale. For example, if you plot a drawing at a scale of ¼
= 1, you calculate the scale factor for text height as follows.

¼" = 1"   (i.e., the scale factor is 4)

The scale factor for an architectural drawing that is to be plotted at a scale of ¼" = 1’0" is
calculated as given next

¼" = 1’0", or ¼" = 12", or 1 = 48

Therefore, in this case, the scale factor is 48.

Figure 7-59  Specifying different features to text style files
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For a civil engineering drawing with a scale 1"= 50', the scale factor is shown next.

1" = 50', or 1" = 50X12", or 1 = 600

Therefore, the scale factor is 600.

Next, calculate the height of the AutoCAD LT text. If it is a full-scale drawing (1=1) and the text
is to be plotted at 1/8" (0.125), it should be drawn at that height. However, in a civil engineering
drawing, a text drawn 1/8" high will look like a dot. This is because the scale for a civil engineering
drawing is 1"= 50', which means that the drawing you are working on is 600 times larger. To
draw a normal text height, multiply the text height by 600. Now, the height will be as calculated
below.

0.125" x 600 = 75

Similarly, in an architectural drawing, which has a scale factor of 48, a text that is to be 1/8" high
on paper must be drawn 6 units high, as shown in the following calculation:

0.125 x 48 = 6.0

It is very important to evaluate scale factors and text heights before you begin a drawing. It would
be even better to include the text height in your prototype drawing by assigning the value to the
TEXTSIZE system variable.

CHECKING SPELLING
You can check the spelling of text (text generated by the TEXT or MTEXT commands) by using
the SPELL command. The prompt sequence is given next.

Command: SPELL
Select object: Select the text for spell check or enter ALL to select all text objects.

If no misspelled words are found in the selected text, then AutoCAD LT displays a message. If
the spelling is incorrect for any word in the selected text, AutoCAD LT displays the Check
Spelling dialog box, as shown in Figure 7-60. The misspelled word is displayed under Current
word, and correctly spelled alternate words are listed in the Suggestions box. The dialog box
also displays the misspelled word with the surrounding text in the Context box. You may select
a word from the list, ignore the correction, and continue with the spell check, or accept the

Menu: Tools > Spelling
Command: SPELL
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change. To add the listed word in the custom dictionary, choose the Add button. The dictionary
can be changed from the Check Spelling dialog box or by specifying the name in the
DCTMAIN or DCTCUST system variables. The dictionary must be specified for the
spell check.

Note
You can also rename and use the MS Word dictionary or any other dictionary. Choose the Change

Dictionaries button to display the Change Dictionaries dialog box and enter the new dictionary
name with the .cus extension.

TEXT QUALITY AND TEXT FILL
AutoCAD LT supports TrueType fonts. You can use your own TrueType fonts by adding them
to the Fonts directory. You can also keep your fonts in a separate directory, in which case you
must specify the location of your fonts directory in the AutoCAD LT search path.

The resolution and text fill of the TrueType font text is controlled by the TEXTFILL and
TEXTQLTY system variables. If TEXTFILL is set to 1, the text will be filled. If the value is set
to 0, the text will not be filled. On the screen the text will appear filled, but when it is plotted the
text will not be filled. The TEXTQLTY variable controls the quality of the TrueType font text.

Toolbar: Text > Find
Menu: Edit > Find
Command: FIND

 Figure 7-60  The Check Spelling dialog box



Controlling the Drawing Display and Creating Text                                                       7-59

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

The value of this variable can range from 0 to 100. The default value is 50, which gives a
resolution of 300 dpi (dots per inch). If the value is set to 100, the text will be drawn at 600 dpi.
The higher the resolution, the more time it takes to regenerate or plot the drawing.

FINDING AND REPLACING TEXT
You can use the FIND command to find and replace the text. The text could be a line text

created by the TEXT command, paragraph text created by the MTEXT command,
dimension annotation text, block attribute value, hyperlinks, or hyperlink description. When
you invoke this command, AutoCAD LT displays the Find and Replace dialog box, as shown in
Figure 7-61. You can use this dialog box to perform the following functions.
Find Text
To find the text, enter the text you want to find in the Find text string edit box. You can search
the entire drawing or confine the search to the selected text. To select the text, choose the Select
Objects button. The Find and Replace dialog box is temporarily closed and AutoCAD LT
switches to the drawing window. Once you have selected the text, the Find and Replace dialog
box is redisplayed. In the Search in drop-down list, you can specify if you want to search the
entire drawing or the current selection. If you choose the Options button, AutoCAD LT displays
the Find and Replace Options dialog box, as shown in Figure 7-62. In this dialog box, you can

Figure 7-61  The Find and Replace dialog box
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specify whether to find the whole word and whether to match the case of the specified text. To
find the text, choose the Find button. The found text, with the surrounding text, is displayed in
the Context area. To find the next occurrence of the text, choose the Find Next button.

Replacing Text
If you want to replace the specified text with the new text, enter the new text in the Replace with
edit box. Now, if you choose the Replace button, only the found text will be replaced. If you
choose the Replace All button, all occurrences of the specified text will be replaced with the new
text.

Answer the following questions and then compare your answers to those given at the end of
this chapter.

1. Tables in AutoCAD LT are created using the TABLET command. (T/F)

2. The ALL option of the ZOOM command displays the drawing limits or extents, whichever
is greater. (T/F)

3. While using the ZOOM scale option, with respect to the current view, you have to enter a
number followed by an X.  (T/F)

4. You can use the scroll bars to pan the drawing in any direction.  (T/F)

5. The VIEW command does not save any drawing object data. Only the  __________
parameters required to redisplay that portion of the drawing are saved.

6. Multiple lines of text can be entered at any desired location in the drawing area with a single
__________ command.

Figure 7-62  The Find and Replace Options dialog box

Self-Evaluation Test
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7. With the __________ justification option of the TEXT command, AutoCAD LT adjusts the
letter width to fit the text between the two given points, but the height remains constant.

8. In the MTEXT command, the height specified in the In-Place Text Editor does not affect
the __________ system variable.

9. With the __________ command, to edit a single line text, you can change the text string in
the window, but for a multiline text you must choose the Full editor button in the Content
edit box.

10. You can use the __________ system variable to specify the new font mapping file.

Answer the following questions.

1. You cannot insert a field using the MTEXT command. (T/F)

2. If the BLIPMODE variable is set to On, blip marks do not appear on the screen. (T/F)

3. With the ZOOM command, the actual size of the object changes. (T/F)

4. The REDRAW command can be used as a transparent command. (T/F)

5. The  TEXT command does not allow you to see the text on the screen as you type it. (T/F)

6. Which command recalculates all the objects in a drawing and redraws the current
viewport only?

(a) REDRAW (b) REDRAWALL
(c) REGEN (d) REGENALL

7. Which of the following commands cannot be used transparently?

(a) ZOOM (b) PAN
(c) VIEW (d) REDRAW

8. How many views are saved with the Previous option of the ZOOM command?

(a) 6 (b) 8
(c) 10 (d) 12

9. In the In-Place Text Editor, which of the following characters is used to stack the text  with
a diagonal line without using the Autostack Properties dialog box?

Review Questions
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(a) ̂ (b) /
(c) # (d) @

10. Which command can be used to create a new text style and modify the existing ones?

(a) TEXT (b) MTEXT
(c) STYLE (d) SPELL

11. The four main text alignment modes are __________, __________, __________, and
__________.

12. You can use the __________ command to write a paragraph text whose width can be specified
by defining the  __________ of the text boundary.

13. When the Justify option is invoked, the user can place text in one of the __________
various alignment types by selecting the desired alignment option.

14. The text created by the __________  command is  a single object regardless of the number
of lines it contains.

15. Using the MTEXT command, the character __________ stacks the text vertically without a
line (tolerance stack).

16. If you want to edit text, select it and then right-click such that the various editing options
__________ in the menu become available.

17. You can view the entire drawing (even if it is beyond limits) with the help of the
__________ option.

18. In the ZOOM Window option, the area inside the window is __________to completely
__________ the current viewport.
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       Figure 7-63  Drawing for Exercise 3 Figure 7-64  Drawing for Exercise 3 (After changing
the text)

Exercises

Exercise 3 General
Write the text, shown in Figure 7-63, on the screen. Use the text justification that will produce
the text as shown in the drawing. Assume a value for text height. Use the PROPERTIES palette
to change the text, as shown in Figure 7-64.

Write the text on the screen, as shown in Figure 7-65. You must first define new text styles using
the STYLE command with the attributes, as shown in the figure. The text height is 0.25 units.

      Figure 7-65  Drawing for Exercise 4

Exercise 4 General
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Exercise 6 Mechanical

Figure 7-67  Drawing for Exercise 6

Exercise 5 Mechanical

Figure 7-66  Drawing for Exercise 5

Draw the sketch shown in Figure 7-66 using the draw, edit, text, and display commands. Do not
dimension the drawing.

Draw the sketch shown in Figure 7-67. Use the MIRROR command to duplicate the features
that are identical. Also, add the text shown in the figure. Use the display commands to facilitate
the process. Do not dimension the drawing.
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Figure 7-68  Drawing for Exercise 7

Exercise 7 Mechanical

Draw Figure 7-68 and also add the text shown in the figure. Use the display commands to
facilitate the process. Do not dimension the drawing.

Draw the sketch shown in Figure 7-69. Use the MIRROR command to duplicate the features
that are identical. Use the display commands to facilitate the process. Add the text to the
drawing but do not dimension the drawing.

Exercise 8 Mechanical

Figure 7-69  Drawing for Exercise 8
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Problem Solving Exercise 2 Architectural

Problem Solving Exercise 1 Architectural

Figure 7-70  Drawing for Problem Solving Exercise 1

Draw the sketch shown in Figure 7-70 using the draw, edit, and display commands. Also add the
text to the drawing. Assume the missing dimensions. Do not dimension the drawing.

Draw Figure 7-71 using AutoCAD LT’s draw, edit, and display commands. Also, add text to the
drawing. Assume the missing dimensions. Do not dimension the drawing.
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Figure 7-71  Drawing for Problem Solving Exercise 2
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Answers to Self-Evaluation Test
1 - F, 2 - T , 3 - T, 4 - T , 5 - view , 6 - TEXT, 7 - Fit, 8 - TEXTSIZE, 9 - PROPERTIES,
10 - FONTMAP


